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Data Wranglin’ 

 

You can’t escape it. If you work in an office, a lot of what you do revolves around client 

information. Contact information, client notes, and a myriad of other bits of data here 

and there. This session deals with using databases, from Excel to Access, to get that 

data under control, and use it for projects such as mail merges and report writing. 

Strong mouse skills and basic keyboarding skills are required for this session. 

Presented by: 
Shawn D. Gramiak 

Consultant and Top Hog 
Grunt Multiservice 

 

When the job's too big, remember the pig! 

Shawn D. Gramiak  7907 - 80 Avenue  Edmonton  AB  T6C 0S5  
Phone: (780) 466-9324 

E-mail: shawn@gruntmulti.com 
  

mailto:shawn@gruntmulti.com
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Data, Data Everywhere. And I Don’t Know What to Think. 

You can’t help it. It is inescapable. We are surrounded by a sea of 

information, and we have to make sense of it all. 

We have to: 

 Input it 

 Import it 

 Export it 

 Filter it 

 Merge it 

 Share it 

 Link it 

And most importantly, Preserve it. 

Data Management is one of those amorphous terms that means different 

things to different people. On the whole, however, it is usually a pretty vast 

subject, and an hour and a half is about long enough the scratch the tip of 

the iceberg. 

With that in mind, this session will involve a handful of skills you can use to 

work with data in a very practical, day to day sense. Hopefully, it will give 

examples of some of the skills required to fulfill that little list of skills near 

the top of the page. 

Specific Skills We Will Work to Cover in This Session: 

 Flipping text into a table. 

 Copying and Pasting Data as a Method of Data Input. 

 Outlook – Importing and Exporting Data to PST’s and/or Excel for 

backup. 

Excel: 

 Using forms to Enter Data in Excel. 

 Validation Rules 
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 Using Autofilter 

 Basic Data Sorts 

 Mail Merges with Excel 

 Paste Linking Between Word and Excel to share data. 

Access: 

 Constructing a Basic Access Database 

 Importing Data from Excel into Access 

 Database Queries for Reports and Mail Merges 

What is a Database? 

Simply put, a database is a base of data. A collection of information 

organized into sortable records. Databases can be created in Word, Excel 

or Access, and we have all seen custom-made databases that have been 

constructed in languages like Visual Basic or SQL. However, almost all 

databases are based on one very simple thing. It is a simple thing we have 

all used at one point or another, either on a computer or on a sheet of 

paper. 

The most rudimentary database we usually work with day to day is a 

contact database. We can either create our own contacts database, or if we 

use an email program, the contact database is built right into that program. 

One could even argue that if you still use an address book that your carry 

with you in your pocket or purse, that that is an example of a ―hard copy‖ 

database. 

Another example of a database we may come into contact with every day is 

when we go to the grocery store. As the person at the checkout scans the 

barcode on that can of beans, the computer in the till interacts with a 

database to print your receipt, as well as tell the inventory database that 

another can of beans will need to be ordered to be put back on the shelves. 

After a week’s worth of grocery sales, the store manager can run a report 

from the database that cannot only show weekly profits, but also let them 

know what groceries have to be ordered for the store. 
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All Roads Lead to a Table 

The core of any database, and the basic storage unit of any database, is a 

table. The table includes an item called a header row, which contains the 

field names (the general category) of each type of data. For instance, 

throughout these examples, we may use field names like first name, last 

name, address, city, province, postal code, etc.  

The header row is very important. Not only does it tell the user what kinds 

of data you are tracking in your database, but it also helps connect other 

items like queries, reports or merge documents to our database. Other 

programs look for the information in that header row to figure out how a 

report may be constructed, or what fields are required in items such as 

form letters. 

After the header row come the actual data records. A record, simply put, is 

a single row of data in a table. We usually try to include in each record a 

unique value that will differentiate one record from another. A good 

example of this is something like an employee number. Some people may 

rely on a person’s last name as the unique value, but if you have a contacts 

database with a hundred people, the chance of two people having the 

same last name are pretty good. A unique value such as an employee 

number, or even a record number, makes it easier to find a single record in 

a mass of data. Some database programs may assign their own unique 

values to each record, or you can opt to go without them, but that latter 

choice may cause issues as the database grows. 

However, let’s look at putting together a basic table in Microsoft Word. 

NOTE: The steps in this handout are applicable to Microsoft Office 2007 

and 2010. If you are using Microsoft Office 2003, you will notice a distinct 

visual difference, and a difference in the steps you follow. You will still be 

able to use the steps in this handout, but you may need to modify them 

slightly for use in Office 2003 applications. 
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Set a Table in Word 

1. Open Microsoft Word 

2. Click the Insert Tab your Ribbon.  

3. Click on the Table button on the Ribbon. 

4. A grid with a group of squares will pop out from this button. 

5. Once that grid that pops out, just move your mouse pointer from the 
upper left square, across as many squares as you need for columns.  

6. Also move the pointer down as many squares as you need for rows. 
If you need more rows or columns than the grid initially shows, just 
keep moving your pointer beyond the edges of the initial grid, and the 
grid will expand to accommodate your request for additional columns 
or rows. 

7. Click on the last square you have selected on the grid, and you 
should see a table on your page with the required number of columns 
and rows. 

a. NOTE: it is good to figure out how many rows and columns you 
need in your table before making inserting the table. Although 
you can add more columns or rows later, it is still better to get it 
right the first time around. 

 

One of the nice things about Word 2007 and Word 2010 is that when you 

use the method above, a feature called ―Live Preview‖ comes into play, and 

if you watch the page you are working on, the table will appear on the page 

as you click and drag over the squares on the grid. 

From there, you can simply click in the table, and type the requisite data 

into the table. Once again, the top row of the table will include the field 

names (essentially the labels that describe the data that follows). You can 

move between the cells to enter data by using the cluster of 4 arrow keys, 

usually located in the lower right corner of any keyboard. 

In the end, you may end up with a table that looks like this: 
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Fname Lname Title Organization Address1 Address2 

 

City Pro

vinc

e 

Postalco

de 

Sheila Smith ED Bigtown Food Bank Standard Bldg.  10021-134 St Edmonton AB T5J 1R7 

Wilf Boscoe   10426-82 Avenue  Edmonton AB T5T 1L9 

Don Smyth Chair Town Services 4412-88 St  Edmonton AB T5P 1B3 

Walt Earwig   Rockefeller Building 10234-Jasper Avenue Edmonton AB T5J 4R7 

Einstein Jones Secretary Hospice 

Foundation 

Rockefeller Building 10234-Jasper Avenue Edmonton AB T5J 4R7 

 

For your information, some arbitrarily chosen short labels have been used 

for the field names. The field names, and their meanings are as follows: 

a. fname indicates first name of contacts 
b. lname indicates last name of contacts 
c. title  indicates a title such as Chair, or Executive Director 
d. organization indicates the name of the Organization  
e. address1 indicates the first line of an address 
f. address2 indicates the second line of an address, if required 
g. city  indicates the city 
h. province indicates the province 
i. postalcode indicates the postal code 

 

Keep in mind, these were personal choices for field names. When you use 

your own field names, keep in mind that that may pose problems later if 

you are trying to import the data into an Access database. The problems 

are not insurmountable, but may require a process called mapping so that 

that Access database realizes ―fname‖ actually stands for ―First Name‖. 

This brings us to a quick note about uniformity and consistency. 

Uniformity and Consistency 

Databases thrive on a uniformity and consistency of data. Information 

entered in the same format each and every time. So for instance, if you are 



Data Wranglin’ presented by Shawn Gramiak Page 7 of 33 

entering the province for a specific contact, it makes sense to use the two 

letter acronym for that province, since it is the postal service standard. 

Therefore, you have to make sure that anyone else using that same 

database enters provinces the same way.  

What happens if you don’t? What if one person uses AB for Alberta and 

another uses Alberta? Then when it comes time to filter the data and sort 

records, if you are looking for all of the records in Alberta, and you filter by 

―AB‖, any records featuring Alberta may not be found. 

Similarly, if I use a table that uses fname as a field name, and another 

refers to the same type of data as First Name, I may need to ―map‖ the 

data. This means I tell the database I am importing the data into that 

―fname‖ and ―First Name‖ are the same thing. 

When we do a mail merge a little later, we will touch on the subject of 

mapping. 

Another thing database designers might do is say right from the outset that 

all data tables they use will follow one field naming system. So every table 

of data you have uses the same field names. This makes combining data 

between tables much easier.  

In addition, database designers might use items like validation rules to 

―force‖ people inputting data to input the data in a certain way. So you 

could create a validation rule that makes a person input Alberta as AB. If 

they don’t, the program will pop up an error message, instructing them to 

use the two letter acronym. 

Last but not least, you can create an actual ―rule book‖ or policy manual 

that people inputting your data have to read and adhere to. 

On the opposite end of the scale, you can also create filters and searches 

with Boolean operators, and say that you wish to have records returned 

that include ―AB or Alberta‖. 
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However, IT IS STRONGLY SUGGESTED that you make people enter 

their data the same way, and that will alleviate a lot of the need creating 

overly complicated queries and filters. 

But be prepared. Databases are logical. People are not. 

Quickly Flipping Text Into a Table. 

In the best of all worlds, if you have to input additional data into a table, it is 

great if you get that additional data already in a tabular format. Then you 

can usually just copy and paste the records from one table into another. 

Sometimes, however, you may be emailed an address list that is not in a 

tabular format.  

First off, always try to get additional data in an electronic format. You will 

still get people who will want to hand you a hard copy, in which case you 

will have to retype the date, or use a scanner with an Optical Character 

Recognition Program (OCR) to scan the list in as a Word or Plain text 

document. Either method is cumbersome. If they email you a list of 

addresses, it is pretty simple to change an address like this: 

Shawn Gramiak 

7907-80 Avenue 

Edmonton   AB   T6C 0S5 

Into a format like this: 

Shawn,Gramiak,7907-80 Avenue,Edmonton,AB,T6C 0S5 

Now let’s say I get a variety of addresses, and reformat them to look like 

this: 

Shawn,Gramiak, , ,7907-80 Avenue, ,Edmonton,AB,T6C 0S5 

Joe, Dorn, Executive Director, Wilton & Co., ,12991-88 

Street,Edmonton,AB,T5L 1P2 
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Cindy,Trent,Volunteer,HELP Society,Smalltown Youth Centre,9976-88 

Street,Lloydminster,AB,T4M 1L7 

Now note that in the above format, each piece of data has been separated 

with a comma. We are using the table that was featured a little earlier in the 

handout, and for any places in the addresses where we do not have 

information (for instance, a person’s Title) we insert a blank space 

surrounded by commas. 

Now to ―flip‖ this data into a table: 

1. Select the data by clicking and dragging over it. 

2. Click the Insert Tab your Ribbon.  

3. Click on the arrow at the bottom of theTable button on the Ribbon. 

4. From the menu that appears, click on Convert Text to Table. 

5. This will present a window that might say it only recognizes two 

columns in your data. Look near the bottom of this little window for a 

section entitled ―Separate text at‖. In this area, click the ―Commas‖ 

option. You may see that the number of columns now changes to 9. 

6. Click the OK button. You should see that addresses change into a 

table that looks like this: 

Shaw
n 

Gramia
k 

  7907-80 
Avenue 

 Edmonton A
B 

T6
C 
0S
5 

Joe Dorn Executiv
e 
Director 

Wilton 
& Co. 

 1299
1-88 
Street 

Edmonton A
B 

T5L 
1P
2 

Cindy Trent Volunte
er 

HELP 
Societ
y 

Smallto
wn 
Youth 
Centre 

9976-
88 
Street 

Lloydminst
er 

A
B 

T4
M 
1L7 
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Now if you were to highlight and copy the table above, and go to the table 

earlier in this handout, you could add an empty row to the bottom of the 

previous table and paste the new data into it. 

In fact, tables are pretty flexible creatures. When it comes to Word and 

Excel, for instance, taking data from a Word document and dropping it into 

an Excel database can sometimes be simply a matter of copying and 

pasting. 

Copying and Pasting Data Between Programs 

Be aware that some programs may not react to copying and pasting, but 

Word Excel seem to be just fine with it. 

Once again, in order for this to work well, the structures of the tables in 

both programs should be similar. Better yet, they should be EXACTLY the 

same. 

So let’s say we created a table in Excel that looks like this: 

 

The beauty of Excel is that when we open an Excel workbook, the table is 

already built for us, all we need to do is enter the appropriate data into each 
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cell. We can also use our arrow keys to move from cell to cell as we enter 

data. 

It is also usually a good idea to bold the text in your header row, as that 

helps identify it as a row that shouldn’t be moved if you sort the data. 

Now if we create our table in Excel, and we copy data from a Word 

document (like the second table we created earlier in this handout) I can 

simply paste it into the next empty row in the Excel table (for instance, I 

would click on cell A7 and paste the data from the word table in). The end 

result should look like this. 

 

NOTE: You might find that you will need to ―clean up‖ or reformat the data 

you paste in, so that the data looks the same. The data itself, even if you 

don’t reformat it, will still work in processes like mail merges. 

We will return for a closer look at Excel in a little while. 

Now let’s take a look at another program that we may a store a lot of data 

in, and how we can protect it. 
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Microsoft Outlook 

In this handout, we will look at Outlook, which is a program that is used in a 

lot of businesses and large organizations for people to manage their email, 

calendars, contacts and task lists. 

Outlook is a huge topic unto itself. If you are unfamiliar with the program, 

take a look at the tutorial handouts at the website www.officetutorials.com 

for a good overview of Outlook. 

Otherwise, you can do a Google Search for ―Outlook 2010 tutorials‖ and 

you will find hundreds of thousands of potential results. Of course, if you 

are using an earlier version of Outlook, you can modify your search to look 

for the correct version. 

However, the specific topic we will focus on in regard to Outlook is 

preserving the information within it. Very often, we might have to take the 

information presently within Outlook and either back it up to a device we 

can remove from the computer for safe keeping, and/or move that data to a 

new or different computer. 

Now some people resign themselves to retyping all of their contact 

information back into their new computer, but Outlook allows you to save all 

of your Outlook data to a file called a .pst 

This sort of file can allow you to save not only your contact information, but 

all of the entries on your calendar AND all of your email messages. 

The process of creating a .pst is often referred to as Exporting. If I am 

bringing the information from a .pst into a new or different version of 

Outlook, that is called Importing. Let us first talk about Exporting our 

Outlook Data to a .pst. 

Export Outlook items to an Outlook Data File (.pst) 

Information in Microsoft Outlook 2010 can be exported to an Outlook Data 
File (.pst). This provides a way transfer Outlook 2010 items to another 
computer or to make a backup. 

http://www.officetutorials.com/
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Folder properties such as permissions and views are not preserved when 
you export to an Outlook Data File (.pst). Only the content itself is exported. 

1. Click the File tab. 

2. Click Options. 

3. Click Advanced. 

4. Under Export, click Export. 

Note The Import and Export Wizard can also be opened by clicking 
the File tab, clicking Open, and then clicking Import. 

5. Click Export to a file, and then click Next. 

6. Click Outlook Data File (.pst), and then click Next. 

7. Select the account — a top level folder — that you want to export. This 
enables exporting all mail, calendar, contacts, tasks, and notes if 
available for that account. 

Note Only information for one account can be exported information 
at a time. 

8. Make sure that the Include subfolders check box is selected. 

9. Click Next. 

10. Click Browse to select where you want to save the Outlook Data File 
(.pst) and to enter a file name. Click OK to continue. 

Note If you have previously used the export feature, the 
previous folder location and file name appear. Make sure that 
you change the file name if you want to create a new file 
instead of using the existing file. 

11. If you are exporting to an existing Outlook Data File (.pst), under 
Options, specify what to do when exporting items that already exist in 
the file. 

12. Click Finish. 

The export begins immediately unless a new Outlook Data File (.pst) 
is created or the export is to an existing file that is password 
protected. 
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 If you are creating a new Outlook Data File (.pst), an optional password 

can help protect the file. When the Create Outlook Data File dialog box 

appears, enter the password in the Password and Verify Password 

boxes, and then click OK. In the Outlook Data File Password dialog 

box, enter the password, and then click OK. 

 If you are exporting to an existing Outlook Data File (.pst) that is 

password protected, in the Outlook Data File Password dialog box, 

enter the password, and then click OK. 

If you want to export items for multiple accounts, repeat these steps for 
each account. 

Conversely, if you want to bring data back from an existing .pst, you would 

have to Import that .pst. 

Import Outlook items from an Outlook Data File (.pst) 

When you want to migrate Outlook messages, contacts, calendar items, 
tasks, and notes from one computer to another or restore a backup of your 
Outlook data, the Import and Export Wizard is the easiest way to complete 
the task. 

1. Click the File tab. 

2. Click Open. 

3. Click Import. 

4. In the Import and Export Wizard, click Import from another program or 
file, and the click Next. 

5. Click Outlook Data File (.pst), and then click Next. 

6. Click Browse, and then choose the file to import. 

Note Under Options, it is recommended that you click Do not import 
duplicates unless you want the imported information to replace or 
duplicate items already in Outlook.  

7. Click Next. 
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8. If a password was assigned to the Outlook Data File (.pst), you are 
prompted to enter the password, and then click OK. 

9. Set the options for importing items. The default settings usually don’t 
need to be changed. 

 The top folder — usually Personal Folders, Outlook Data File, or your 

email address — is selected automatically. 

 Include subfolders is selected by default. All folders under the folder 

selected will be imported. 

 The default selection of Import items into the same folder in matches 

the folders from the imported file to the folders in Outlook. If a folder 

doesn’t exist in Outlook, it will be created. 

10. Click Finish. 

Tip If you want to import or restore only a few items from an Outlook Data 
File (.pst), an easier way is to open the Outlook Data File, and then in the 
Navigation Pane (Navigation Pane: The column on the left side of the 
Outlook window that includes panes such as Shortcuts or Mail and the 
shortcuts or folders within each pane. Click a folder to show the items in the 
folder.) click and drag the items from Outlook Data File folders to your 
existing Outlook folders. 

Now if you have created a .pst, and you want to back it up to an external 

device like a USB key (memory key, flash drive) follow these steps: 

1. Plug the key into your computer and give the computer a few 

minutes to realize that the key has been inserted. You might get a 

screen asking what you want to do with the key. You can cancel or 

close the screen. 

2. Find where you stored the .pst file on your computer. 

3. Right-click on the .pst file. 

4. From the menu that flies up, move your pointer to the Send To: 

command. 

javascript:AppendPopup(this,'-1022316327_1')
javascript:AppendPopup(this,'-1022316327_1')
javascript:AppendPopup(this,'-1022316327_1')
javascript:AppendPopup(this,'-1022316327_1')
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5. From the menu that flies out, click on the name or letter 

representing the memory key (it will usually be at the bottom of the 

list.) 

You can use the same steps to copy your .pst to an external hard drive as 

well. 

NOTE: You can also use the Export process above, with minor 

modifications to the steps, to save your Contacts list to an Excel workbook, 

if that is all you want to back up. 

When you choose to Export just your contacts, you will choose the option 

to ―Export to a file‖ and when you are asked which type of file, you can 

choose Comma Separated Values (a .csv file). A .csv file is largely 

understood by most other database programs, and by default, Windows will 

usually choose Microsoft Excel as the default program to open .csv files. 

When it comes to exporting your data from Outlook, most people elect to 

use the .pst method, simply because it saves ALL of your data (Email, 

Contacts, Calendars, Tasks, etc.). 

In other email programs, you may also have an Export command, but often, 

it may only export your Contacts (sometimes called addresses). If .pst is 

not an option to export to, .csv is the safest route to go. 

Also note that if you are using a web-based email program like Hotmail, 

Gmail or Yahoo, the above steps may not work. With web-based email, it is 

often assumed that the web server computers that contain your email 

account and address book are protected by the people who are offering 

you your email service. If you want to backup your messages and email 

addresses to an external storage device, you may have to set up a 

program like Outlook or Windows Live Mail to bring the messages and 

addresses from your webmail account on to your own computer. In cases 

of webmail services, your messages and addresses are actually not stored 

on your computer, all of that information is stored at the company that gives 

you your webmail. If you use a program like Outlook or Windows Live Mail, 

that actually stores the messages and contacts/addresses on your 
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computer, you can then you can back them up to an external storage 

device. 

Now back to Excel! 

Excel as a Database 

Excel is often one of the first programs people use to assemble a basic 

database. 

Excel offers some advantages, as processes such as filtering and sorting 

are a little bit smoother and easier in Excel. Excel is also nice because the 

Excel workbook is basically just a huge table in the first place. It has more 

columns and rows on one sheet than most people ever need.  

Excel also shares it’s data with other  programs really easily. 

Last but not least, you can build rules into an Excel database that force 

people to input data properly. 

Let’s start by looking at some ways to easily enter data into our Excel 

database. 

The Form Feature in Excel 

Although you can simply add data to an Excel worksheet the same way we 

have done previously (clicking in an empty row, filling in cells and moving 

from cell to cell using your arrow key), you might find with databases that 

collect more than 9 pieces of data per record that this can get complicated. 

Some people find using the data form feature in Excel to be useful. To use 

this, you will first need to click somewhere in the header row or your table, 

then add the form button to the Quick Access Toolbar in the upper left 

corner of your screen. 
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Add the Form button to the Quick Access Toolbar 

1. Click the arrow next to the Quick Access Toolbar, and then click More 
Commands. 

2. In the Choose commands from box, click All Commands. 

3. In the list box, select the Form button, and then click Add. 
 

If you have clicked in the header row of table, and then clicked on the Form 

button, you should see a form pop up in the middle of the screen. You can 

then use this form to enter new records, snoop through existing records, 

and even delete records. 

Validation Rules 

As mentioned earlier in this handout, you want to make sure that everyone 

is typing data into your database the same way. One way to force people to 

enter data in a specific format is to use a validation rule. 

So let’s use the example of creating a rule to restrict how people input the 

provinces in our Excel table. 

Create a Data Validation Rule. 

1. Highlight the cell or cells that you wish to apply the rule to. 

2. Click the Data tab on the Ribbon. 

3. From the Data tab, click on the Data Validation button. 

4. From the Data Validation window that appears, make sure you are on 

the Settings tab. 

5. Click the drop down arrow on the box titled Allow. 

6. From the list that drops down, click on Text length. 

7. Click the drop down arrow on the Data box. 

8. From the list that drops down, click on Equal to. 

9. In the Length box, type 2 (for the number of characters for a 

provincial acronym). 

10. Click the Error Alert tab. 

11. In the Title box, type ―Two Letter Acronym‖ (without quotes). 
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12. In the Error Message box, type in a brief message telling the user 

how they should be typing in data for the province. 

13. Click the OK button on this window. 

14. Test the Validation rule. 

You should find that if you try typing Alberta into one of the cells with the 

validation rule applied, that the moment you try to move away from the cell, 

the error message will pop up, allowing you to Retry typing the correct 

format of province into the cell. 

This is just one example of creating a Validation Rule. You will find that if 

you play around with these steps, there are a variety of variables you can 

set to restrict how data gets entered into specific cells. 

Autofilters in Excel 

To quickly filter data in an Excel table: 

1. Click in the Header Row of your data table. 

2. Click the Data tab on the Ribbon. 

3. Click the Filter button. 

4. Drop down arrows will appear by each heading, then you can use them 

to drop lists to filter your data. You can also remove filters using the drop 

down arrows. 

Remember that when you drop the lists using the drop down arrows, you 

can erase the check mark by Select All option, and put check mark(s) by 

the criteria you wish to filter by. Clicking the OK button will activate the filter 

process. You can drop the list again, and use the Clear filter from 

command to erase any filters you have applied, and return the database to 

an unfiltered state. 
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Basic Data Sorts in Excel 

If you are on your Data tab anyway, you will see in the same 

neighbourhood as your Filter button, there are Sort buttons. Using Sort 

buttons are simple. 

1. Click in the column you wish to sort. 

2. Click either the Sort A to Z button or Sort Z to A button, to perform 

ascending or descending sorts. 

3. Clicking on the actual Sort button will allow you to sort by more 

than one column. 

Keep in mind that when sorting by columns, the corresponding data from 

each record moves with the criteria you are sorting. Therefore, you should 

never be in a position where you sort the data in one column, and that data 

comes out of sequence with the rest of the data in the database. 

Mail Merges with Excel 

Mail Merges are very powerful ways to share data between applications, 

and are most commonly used to create personalized form letters and 

mailing labels. 

Although you will be taken through a practical example during the session, 

the actual steps are enough to fill a handout of their own. 

That’s why we will suggest that you find and print the mail merge handouts  

at www.officetutorials.com 

The steps in the Word 2003 Mail Merge tutorial basically work the same 

way in Word 2007 and Word 2010. The only slight exception will involve 

how you get to the Mail Merge Wizard. 

  

http://www.officetutorials.com/
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How to Start the Mail Merge Wizard in Office 2007 or 2010 

1. Click the Mailings tab on the Ribbon. 

2. Click the Start Mail Merge button. 

3. From the list that drops, click on Step by Step Mail Merge Wizard. 

This will bring up a panel on the right-hand side of your screen. If you read 

the instructions on this panel, it should guide you through the process of 

completing the merge. However, if you print out the Word 2003 Mail Merge 

Handout from www.officetutorials.com that will also take you step by step 

through the remainder of the process. 

Alternatively, you could Google ―how do I do a mail merge in Word 2010‖ 

(without quotes) and you will find numerous online guides and handouts 

that will guide you through the process. 

You might even try looking up videos on Youtube which could guide you 

through doing a basic mail merge in Word. 

Paste-Linking to Share Data Between Excel and Word 

Paste-linking can be used to share data between many applications, not 

just Word and Excel. You can even do Paste-Links between Word and 

PowerPoint, or PowerPoint and Excel. You can even use Paste-link to 

connect two Excel workbooks to share data. 

A very common example of a Paste link is copying a chart created in Excel, 

and Paste-linking it into a Word document, such as a quarterly or annual 

report. 

This is so common that in 2010, when you copy a chart from Excel into 

Word, it is automatically linked. 

What is the advantage? The advantage is that if you change the data in the 

Excel worksheet that the chart is based upon, the chart will update and 

change in the Word document. So I can use the chart in multiple different 

documents, and if I make a change to the chart in Excel, it changes 

throughout all of the other documents.  

http://www.officetutorials.com/
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Paste-linking eliminates the need to cross-reference to make sure multiple 

documents are showing the same data. It helps update multiple documents 

quicker, and it always forces the user to return to the source of the data to 

make edits. So you are only correcting the data in one spot, but that in turn, 

corrects all linked documents. 

Sometimes, depending on what you are copying and pasting, you may 

need to manually establish a Paste-link to make sure updates happen 

across the two programs. 

Making a Paste Link 

1. For this example, you will need a table of data (perhaps a budget) 

already made in Excel, and a Word document that you wish to put a 

copy of that table into. 

2. In Excel, highlight and copy the table of data. 

3. Go to your Word document. 

4. Make sure you are on your Home tab and click the arrow at the 

bottom of the Paste button. 

5. From the menu that drops, click on Paste Special. 

6. From the window that appears, click on the Paste Link option and 

click on Microsoft Excel Worksheet Object from the list that appears. 

7. Click the OK button. 

You may want to save both documents. To test is the linking has actually 

worked, try changing the data in the table in Excel. When you return to the 

Word document, the table should be updated. Word may tell you that the 

document is linked, and will ask if you wish to update the links. If you click 

OK, the update takes place. 

Once again, charts copied and pasted from Excel are automatically linked, 

so you should not need to go through the steps listed above. If the 

automatic updating does not take place, however, you can follow the steps 

above to manually create a link. 
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Using Access for Databases 

Access is an actual database program, and that is what it Is built for. 

It is a close cousin to Excel, but it is much more powerful, but along with 

that power comes much more complexity. 

In this session, we will take a rudimentary look at Access. 

Yet once again, check out the Office 2007 tutorials at 

www.officetutorials.com  for a free handout that will go over the basics in 

more detail. The handout itself is about 51 pages long. 

At this point, however, we can go through a little basic database theory, 

and from there, we can create a simple database. 

Understanding the relationships between tables, forms, queries and reports 

 A Field is a data category that holds a specific type of data. For instance, I 

could have a Data Field of ―First Name‖ in my database, and that would 

contain all of my contacts’ first names. 

 A Record is a collection of Fields. For instance, every record in a Contacts 

database would include fields such as First Name, Last Name, Address, 

City, Province and Postal Code. There would be a record for each and 

every contact in the database.(If the database is well maintained, the 

records would be comprehensive, meaning they would have all possible 

fields filled with the most updated information.)  

Tables are the overall information containers within a database. Any data 

entered into a database winds up being stored in a table. A table can also 

be thought of as a collection of records. 

 Forms are user-friendly screens that act as templates for inputting data.  

 Queries act as filters. When you create and run a query, you are asking for 

specific information from the huge pool of information that the database 

may hold. 

http://www.officetutorials.com/
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 Reports are a cosmetically pleasing way to see the output of queries. 

Think of creating a book report on paper. You take all of the information 

you can get, filter out the unimportant bits, and present the remaining 

information in a clear and understandable format.  

 When building a database, you: 

  

1. Create your tables first, after deciding what data you want to track.  
2. Once the tables are created, you create forms based on those tables, 

allowing users to easily input data into your database.  
3. Once you have entered data into the tables through your forms, you 

can create queries to filter and sort the data.  
4. Once queries are created, reports can be made based upon those 

queries. So a database user can open a report at any time, and see 
the current results of that query.  

 

An example of this would be the database that is used to manage a store. 

All of the products within a store would be listed in tables, along with their 

prices and how many of each item are in stock. When I buy something at 

this store, the clerk enters my purchases through the form on the computer 

screen of their cash register. This information gets fed into the store’s 

overall database. The database also tells the cash register the prices of the 

items, and assists in calculating the grand total of my purchase. All of these 

transactions are entered into the database. At the end of each month (or 

even more frequently), queries are run in the database, and inventory 

reports can be viewed and/or printed out for the store manager to see how 

business is going. 

In this session, the instructor will either take you through the basic steps of 

creating a simple database, or show you a sample that is already 

constructed, and show you the pertinent parts of it, and how they relate to 

each other. 

Once again, for further details on how to build a database step by step, 

print the appropriate handout from www.officetutorials.com 

http://www.officetutorials.com/
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Importing Records Into an Access Database 

The following steps are based on an actual data importation into a 

database. When you do your own record importation into a database, you 

will have to substitute the names of your own Excel spreadsheets and table 

names in Access into the steps. The general process, however, should 

remain the same. 

A Quick Overview of Importing Data 

THE MOST IMPORTANT THING! 

IN THE EXCEL ADDRESS LIST THE HEADINGS MUST EXACTLY 

MATCH THE FIELD NAMES IN THE DATABASE. That means their case 

must match as well.  

YOU DO NOT NEED TO INCLUDE A ―Record Number‖ field in your Excel 

sheet.  Any columns you do not have in your Excel sheet that are in the 

database will simply remain blank after the import of data. 
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Step One: Open the Database 

 

You don’t need to open up the Name and Address Table, you can leave it 

closed. 

If you don’t see the list on the left hand side, click the double arrows on the 

top of the Navigation Pane bar at the left side of the window. If you cannot 

see the Navigation Pane, the arrows will point to the right. They will point to 

the left once the Navigation Pane is visible. 
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Step Two:  Click the External Data Tab 

 

Click the External Data tab and then click the Excel button on the Ribbon. 
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Step Four: Click the Browse button on the Get External Data – Excel 

Spreadsheet Window that Appears 

 

Like any other Browse button, this will open a window that will let you go 

and find where your Excel Worksheet is located on your computer.  
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Step Five: Once You Find Where Your Excel Address List file is 

Located, Click on it, and click the Open button in the lower right 

corner of the window. 

Step Six:  When You Are Returned to the Get External Data – Excel 

Spreadsheet Window, Choose the Table You Want to Import the 

Addresses Into. 
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Make sure to click the circle beside ―Append a copy of the records to the 

table:‖ and click the drop down arrow in the drop down list box. This will 

show you a list of all tables in the database. Click the Name and Address 

item in the list. Then click the OK button in the lower right corner of the 

window. 

Step Seven: Go Through the Import Spreadsheet Wizard 
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When the Import Spreadsheet Wizard appears, MAKE SURE THE 

HEADINGS appear at the top of the data being imported. If they do not, 

you might have to cancel the process, and go back to the Excel worksheet. 

Pull out any rows that are above your headings. Your headings should be 

the only thing at the top of your Excel worksheet. Then try the Import 

process over again. 

If all is going smoothly, however, you can simply click the Next button in the 

lower right corner of the Import Wizard. 

Keep clicking the Next button until you arrive at a window that has a Finish 

button in the lower right corner (you might have to click the Next button a 

couple of times).  

Step Eight: Check to See if the Import was Successful! 
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Double-click the Name and Address: Table to open it up. You should see 

that the addresses are in that table.  

AFTER THE ADDRESSES ARE IMPORTED 

Some of your other data will probably have to be dropped in by hand. You 

may want to try importing other data using this method, but once again, the 

data in the Excel sheets you importing must EXACTLY match what the 

database is expecting. In some instances, you might find it easier just key 

the data back in.  

Database Queries and Mail Merges 

You can use an Access Query (and the results thereof) as a mail merge 

source, just like an Excel worksheet. Since queries are primarily tables 

anyway, you can go through all the regular steps of a mail merge, with the 

exception that as part of the mail merge process, you will connect the 
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merge document to your Access database. When you do this, the mail 

merge will ask whether you wish to connect the document to a particular 

table in the database, or to a specific query. As long as you tell the Mail 

Merge Wizard which query to connect to, you should be able to complete 

the rest of the mail merge process as normal, and the results of the query 

will be incorporated into your form letters, labels etc. 

And In Conclusion… 

Again, we have just scratched the surface of data management. However, 

it is hoped that in this short session, we have at least planted the seeds of 

what a handful of data management skills can do for you. Hopefully you will 

come to see ways you can avoid needless retyping of data, and how you 

can harness data you already have to mass communicate, as well as report 

useful summarized information to you. 

Good luck, and get wranglin’! 


